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STARTUP & ABOUT 

ABOUT SHAREO° / SHARECALENDAR/ SHARECONTACTS for MICROSOFT® OUTLOOK® 
2000/2002/2003/2007/2010 

  

ShareO allows the users to share and 
synchronize their Microsoft Outlook 
Folders* data, such as calendar, e-
mail, contacts, tasks, notes and 
free/busy information, as well as to 
share any windows documents with 
their coworkers and friends without a 
server** expense. 

 

ShareContacts is based on ShareO 
functionality and allows the users to 
share and synchronize their Outlook 
Contacts folders' data and create 
public address book. 

 

ShareCalendar is based on ShareO 
functionality and allows the users to 
share and synchronize their Outlook 
Calendar folders' data and create 
group / public calendars, as well as to 
share Free/Busy information without a 
Exchange Server. 

 

  
We would like to extend a special "thank you" to many customers in the USA, United Kingdom, 
Australia, Belgium, Germany, Switzerland, France, Singapore, and other countries that implemented our 
program for their everyday business needs: from personal and family use for sharing purposes, to real 
management solutions for Medical and Law Offices, Religious Services, technology or software production 
companies. 
*Excluding: Deleted Items, Drafts, Outbox, 4Team Folders, and Schedules4Team Folder. 
  
**POP3, IMAP4, Microsoft Exchange or other e-mail server or service is required. 

° Old product names: ShareOutlook / Calendar4Outlook / Contacts4Outlook. 
  
  

 
© 2003-2010 4Team Corporation 
  

ShareO website 

http://www.shareo.com/�
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END-USER LICENSE AGREEMENT (TRIAL, FULL VERSION)  
  
BY RECEIVING AND/OR USING 4TEAM CORPORATION (ALITTERA LTD INC DBA) USER LICENSE AGREEMENT 
YOU ACKNOWLEDGE THAT THIS IS A BINDING LEGAL AGREEMENT BETWEEN ALITTERA LTD INC. AND USERS OF SOFTWARE AND 
PRODUCTS BELONGING TO 4TEAM CORPORATION, A DBA NAME OF ALITTERA LIMITED, INC. 
IF YOU DO NOT INTEND TO HONOR THIS AGREEMENT, PLEASE TERMINATE THE SOFTWARE INSTALLATION NOW. 
  
DISCLAIMER 
THIS WEB SITE AND THE MATERIALS AND PRODUCTS IN THIS WEB SITE ARE PROVIDED "AS IS" AND WITHOUT WARRANTIES OF 
ANY KIND, WHETHER EXPRESSED OR IMPLIED. TO THE FULLEST EXTENT PERMISSIBLE PURSUANT TO APPLICABLE LAW (AND, 
THEREFORE, THE FOLLOWING MAY NOT APPLY TO YOU), 4TEAM CORPORATION DISCLAIMS ALL WARRANTIES, EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. 4TEAM CORPORATION DOES NOT REPRESENT OR WARRANT THAT THE FUNCTIONS CONTAINED IN THE WEB SITE WILL 
BE UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS WILL BE CORRECTED, OR THAT THIS WEB SITE OR THE SERVER THAT MAKES 
THE WEB SITE AVAILABLE ARE FREE OF VIRUSES OR OTHER HARMFUL COMPONENTS. 4TEAM CORPORATION DOES NOT MAKE ANY 
WARRANTIES OR REPRESENTATIONS REGARDING THE USE OF THE MATERIALS IN THIS WEB SITE IN TERMS OF THEIR 
CORRECTNESS, ACCURACY, ADEQUACY, USEFULNESS, TIMELINESS, RELIABILITY OR OTHERWISE. 
  
RIGHT TO USE AND DISTRIBUTE THE SOFTWARE 
4TEAM CORPORATION, IN ACCORDANCE WITH THIS AGREEMENT, GIVES YOU THE RIGHT TO: 
TRIAL VERSION: USE AND DISTRIBUTE THIS SOFTWARE FOR YOUR PERSONAL OR BUSINESS PURPOSES ONLY AMONG YOUR 
COMPANY (TEAM) MEMBERS FOR 14 DAYS PERIOD. YOU ARE ALLOWED TO INSTALL AND OPERATE THIS SOFTWARE ON YOUR 
COMPUTER SYSTEM.  IT IS ASSUMED THAT YOU ARE USING THE SOFTWARE AS SOON AS IT IS STORED IN YOUR SYSTEM'S MAIN 
MEMORY OR ANY OTHER DATA STORING DEVICE.  
FULL VERSION: USE AND DISTRIBUTE THIS SOFTWARE FOR YOUR PERSONAL OR BUSINESS PURPOSES ONLY AMONG YOUR 
COMPANY (TEAM) MEMBERS. YOU AND YOUR COMPANY (TEAM) MAY USE ONLY THE NUMBER OF COPIES THAT YOU HAVE 
PURCHASED FROM 4TEAM CORPORATION OR ITS DISTRIBUTORS AND THAT IS GRANTED BY THE LICENSE. WHEN THIS SOFTWARE 
IS STORED IN YOUR SYSTEM'S MAIN MEMORY OR OTHER STORING DEVICES, IT IS ASSUMED THAT "YOU ARE USING THE 
SOFTWARE". 

  
THE TRIAL VERSION MAY BE FREELY DISTRIBUTED, PROVIDED THAT SUCH DISTRIBUTION INCLUDES ONLY THE ORIGINAL ARCHIVE 
SUPPLIED BY 4TEAM CORPORATION. YOU MAY NOT ALTER, DELETE OR ADD ANY FILES IN THE DISTRIBUTION ARCHIVE. 
  
COPYRIGHT 
THE COPYRIGHT AND INTELLECTUAL PROPERTY RIGHTS OF THIS SOFTWARE AND ANY ATTACHMENTS TO THIS SOFTWARE ARE 
OWNED BY 4TEAM CORPORATION, AND PROTECTED BY THE COPYRIGHT LAWS OF THE STATE OF FLORIDA, USA, AND 
INTERNATIONAL INTELLECTUAL PROPERTY RIGHT TREATIES. THEREFORE, YOU CANNOT COPY ANY PORTION OF THIS SOFTWARE IN 
ANY FORM, EXCEPT FOR USING OR COPYING IT FOR BACKUP PURPOSES. ALSO, YOU CANNOT TRANSFORM THE CONTENTS OF THE 
SOFTWARE OR CHANGE THE FILE NAMES. 
  
LIMIT OF WARRANTY 
4TEAM CORPORATION DOES NOT WARRANT THAT USING THIS SOFTWARE WILL FIT ALL USERS’ PARTICULAR PURPOSES, AND IS 
NOT LIABLE FOR ANY DAMAGES CAUSED BY THE USE OF THIS SOFTWARE. 
  
SUPPORT 
4TEAM CORPORATION IS SOLELY RESPONSIBLE FOR CUSTOMER SERVICE. EVERY EFFORT SHALL BE MADE TO PROVIDE A SOLUTION 
FOR TECHNICAL QUERIES ABOUT PROBLEMS CAUSED BY THE INSTALLATION OR USE OF THE SOFTWARE INSTALLED IN A USER'S 
SYSTEM. ALL CUSTOMER SERVICE MATTERS SHALL BE DEALT WITH ONLY VIA E-MAIL, QUESTIONS MUST BE ADDRESSED TO 
support@4team.biz. ANY QUESTIONS, COMPLAINTS, COMMENTS OR SUGGESTIONS SHOULD BE SENT TO sales@4team.biz 
  
ACKNOWLEDGEMENT 
HAVING READ AND UNDERSTOOD THIS USER LICENSE AGREEMENT, YOU ACKNOWLEDGE ITS PRIORITY TO ANY ORDER, 
ENGAGEMENT OR ADVERTISEMENT, AND AGREE TO ITS TERMS. 
IF YOU AGREE WITH THIS USER LICENSE AGREEMENT AND WISH TO CONTINUE WITH THE SETUP, PLEASE PRESS 'YES', IF YOU 
DISAGREE AND WISH TO CANCEL THIS SETUP, PLEASE PRESS ”NO”. 
 
ALITTERA LTD INC. 4TEAM CORPORATION 2003-2010© ALL RIGHTS RESERVED 

mailto:support@4team.biz�
mailto:sales@4team.biz�
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INTRODUCING SHAREO / SHARECALENDAR / SHARECONTACTS (FOR MICROSOFT® OUTLOOK® 
2000/2002/2003/2007/2010) 

PRODUCT FORMER NAMES: SHAREOUTLOOK / CALENDAR4OUTLOOK / CONTACTS4OUTLOOK. 
  
ShareO: 
If you are looking for a quick, secure** and easy way of sharing and updating your Microsoft Outlook 
Folders* or easy sharing of any documents, this program is for you. You just need to install ShareO on 
your computer running Outlook 2000/2002/2003/2007/2010 and on computers of your preferred 
teammates, and after a few clicks their folders information will be updated each time you update the 
shared folder on your PC. Your partners will receive the updated items (contacts, e-mail, appointments, 
tasks, emails, notes, journal, document entries, etc.) via regular e-mail. You will be able to update and 
manage all your shared items offline or using any type of Internet connection. It is an easy and effective 
solution for remote companies and groups. 
  
*Excluding: Deleted Items, Drafts, Outbox, 4Team Folders, and Schedules4Team Folder 
**Available with ShareO Security Pack. Not available with the trial version. A separate license and 
activation are required. 
  
ShareCalendar: 
For sharing and synchronizing Microsoft Outlook Calendars only. Creating group / public calendar with 
ShareCalendar has never been easier.  ShareCalendar is the lite version of ShareO. If you are willing to 
share not only Calendar folders, we suggest that you try ShareO. 
  
ShareContacts: 
For sharing and synchronizing Microsoft Outlook Contacts only. Creating of group / public address book 
has never been easier. ShareContacts is the lite version of ShareO. If you are willing to share not only 
Contact folders, we suggest that you try ShareO. 
 

 How it works 
 Features 
 Installation 
 Security Pack 

 
ShareO website 

http://www.shareo.com/�
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 DISCOVER THE 4TEAM GROUPWARE DIFFERENCES: 

 -------------------------------------------------------------- 

    

 

       

 

                  

  Multiple Folders         

  Subfolders          

  Calendar         

  Contacts          

  Tasks           

  E-mail            

  Attachments         

  Custom Forms          

  Notes           

  Journal            

  Documents           

  News              

  Discussions              

------------------------------------------------------------------------ 

    Duplicate management          

    Backup             

    Auto synchronization        

    Reports              

    Dashboard              

    Project Management              

    Work offline        

    Exchange Server accounts          

    Access Rights management          
    Scheduling              

    3 level management              

    Multiple calendar View *           
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    TimeLine Grid View              

    Web Access (4Team Online)              

    Local Server* (4Team 
Server) 

             

    Sharing/Sync Wizard          

    Sharing/Sync Data via 
transferable PST file              

    Sharing/sync data via Email          

    
Sharing/Sync Data via 
transferable file (external 
USB device) 

            

    Sharing/sync data via FTP or 
shared network folder              

    Sharing/Sync Data via 
Google Calendar Service              

    Synchronization, even if 
Outlook is not running             

    Support for Outlook 2007          
    Free FTP Service              

    AES-256 data encryption   4            

    Multi-language Support 
(Spanish, French, German)           

------------------------------------------------------------------------ 
    Downloadable Trial version        

    Free trial phone/email support        

    Trial CD        

    Free 1 year updates         

    Price per license $ *** 49.95  34.95  34.95  24.95  24.95  39.95 34.95 

                    
 

  
For details please check documentation of each product or consult our sales 
representative by phone +1 954 796-8161 or by LiveHelp available from our 
products' website.  

  

  

 

  
***License Price significantly depends on quantity. You can buy additional 
licenses at any time and receive discounts that include the previous purchase. 
Please check Product License & Pricing page.  

  

  

   
4Available with ShareO Security Pack. Not available with the trial version. 
Separate license and activation are required. 

       Products Short Description: 
      

 

  

4Team for MS Outlook is a management tool that allows sharing of the 
Calendar, Contacts, Tasks, Documents and Discussion Board sub folders 
inside a project folder created by the program's administrator. Team members 
assigned to a project as managers are able to update information in the above 
project sub folders. Great for multiple projects.  

  
  
  
  
  

 

  

ShareOutlook/ShareO is a program that allows sharing of practically any 
folder in MS Outlook (except for Outbox, Deleted Items), including your 
personal Calendar folder. The content of a folder propagates to other sharers ' 
PCs, and they are able to update it on their computers. Sharing and 
synchronizing Windows Documents.  

  
  
  

  
 

  

Schedules4Team is used to create an additional Calendar folder in your 
personal Outlook with a "grid" view of all teammates' calendars. Clicking a 
time block in the Grid will display what this person is doing at the moment. 
You can update his/her schedule. It will also be synchronized with your 
personal Calendar folder. A very flexible program.  

  
  
  
  
  

 

  Contacts4Outlook/ShareContacts is a program that is based on the 
ShareOutlook functionality, but can only be used for sharing your personal 

  
  

http://online.4team.biz/�
http://online.4team.biz/registration/SOverview.asp�
http://online.4team.biz/registration/SOverview.asp�
http://outlook.4team.biz/�
http://shareoutlook.4team.biz/�
http://www.shareo.com/�
http://schedules.4team.biz/�
http://contacts4outlook.4team.biz/�
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Contacts folder in Outlook. Your contacts are transported to other users by e-
mail and merged with their contacts or placed in a different Contact folder. 
The users will be able to update them afterwards. A lightened version of 
ShareO!  

 

  

Calendar4Outlook/ShareCalendar is a program that is based on the 
ShareOutlook functionality, but can only be used for sharing your personal 
Calendar folder in Outlook. Your calendar items propagate to other users by 
e-mail and either merge with their calendar items or can be placed in a 
different Calendar folder/subfolder. The users will be able to update these 
items afterwards. Another lightened version of ShareO!  

  
  
  
  

  

  

  
Sync2 Synchronize Microsoft Outlook PST files. Sync Outlook folders 
between multiple PCs without a server using an external USB device or 
shared network folder (LAN), and a shared PST file.  

 

  
  

 

  
Syn2PST Synchronize Microsoft Outlook data between multiple PCs using 
external USB device, shared network folder or FTP. Share and Sync Outlook 
Calendar folders with Google Calendar™ service.  

  

  

   

http://www.sync2.com/�
http://www.sync2pst.com/�
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HOW IT WORKS 

This powerful add-on / plug-in tool for Microsoft® Outlook® are based on functionality of electronic 
messaging (e-mail). When you select Outlook Folders to be shared or make changes in the shared 
folders’ items (contacts, appointments, tasks, e-mails, notes, journal entries), after clicking ”Send and 
Receive” the program converts all changes into compressed and encrypted** data e-mail messages. 
Microsoft Outlook sends them out to all your teammates. Upon receipt of these messages by program on 
their computers, the program decrypts** and converts them back into Outlook items and places them 
into the shared Outlook folder. You can share folders that use standard or custom Outlook forms. 
Windows documents sharing works in the same way. Just add a document (drag and drop) to the shared 
Outlook folder. Also, you can link the selected Windows folder to the shared Outlook folder and, after each 
document save, it will automatically be updated in the linked Outlook folder. The latest version of the 
document will be sent during the next Microsoft Outlook send and receive session. 
  
*Excluding: Deleted Items, Drafts, Outbox, 4Team, and Schedules4Team Folders. 
**Password is required. Available with ShareO Security Pack. Not available with the trial version. Separate license and 
activation are required. 
 

 Sharing Folders 
 Sharing Documents and Files 

 
ShareO web site 

http://www.shareo.com/�
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FEATURES 

Click on the underlined links. 

 Share any** Microsoft Outlook Folders* without a server. Share Outlook Calendar, E-mails, Contacts, 
Tasks, Notes, and Journal Folders. 

 Inbox and Sent Items folders sharing. 

 Share any Documents. Just drag and drop, copy and paste documents from any windows folder to any 
e-mail type Microsoft Outlook folder. 

 Share Files in Any Windows Folder. ShareO automatically sends updated files each time they are 
modified on your hard drive. 

 ShareO Security PackVI for data encryption with the highest available AES-256 standard. Share your 
Outlook data and documents securely and with confidence. 

 Share Microsoft Outlook Folders with your own custom forms and imported items. 

 Share different Microsoft Outlook Folders* with different groups of people. 

 True sharing of Mail Folders. Shared folders with e-mail messages are visible to others the same way 
they are in your Outlook. 

 Free/Busy Information Sharing*V. Share and access yours and your Contacts’ Free/Busy time via the 
Scheduling Tab of the Appointment / Meeting Request or use Group Schedules in the Calendar folder. 
With the Shared Calendar this feature will help you schedule all your meetings and appointments. 
Always know your co-workers' and friends' free/busy time without disclosing the subject and private 
details. 

 Sharing private appointments as blanks. This option will allow you to share private appointments 
without disclosing the appointment subject and other private details, only showing the scheduled time. 
The other users will be able to see your shared private appointments as blanks. Click here to see what a 
blank appointment looks like. 

 Automatic division by data size of data messages sent via e-mail. You can now avoid ISPs' 
(Internet service providers') and e-mail accounts' limitations on sending large amounts of shared data 
and updates. The program will automatically divide the shared data into 5Mb units (by default), 
compress, and send them. It is especially useful for smooth sharing/synchronization of e-mails with 
large attachments, documents, and first-time sharing of large Inbox, Contacts and Calendars folders to 
avoid the loss of shared data due to ISPs' limitations. (Click here to learn how to change the maximum 
size of data e-mails.) 

 Labels (colors) sharing in appointments sharing. (ShareO*** & ShareCalendar*** only) 

 Using the option "View Only", you can "subscribe" your clients to your folders’ data without allowing 
them to modify it. 

 Share attachments in any Outlook item. 

 Notification About Updates. Now when updates are received, you will be notified about them. 
Notification icon in the Windows system tray will allow you to review the list of recently updated folders 
and quickly open this folder in Outlook. 

 "Unread Only" filter button (for Outlook 2002/2003/2007/2010). 

 New! Automatic intelligent duplicate management and auto-merging. No more complicated dialogs and 
manual item comparisons. Sophisticated duplicate detection and merging algorithm to prevent you from 
losing your data. Automatic backup of the whole folder if multiple changes were detected in the shared 
folder. 

 Easy to use and manage with no requirement of special skills: if you know how to work with MS 
Outlook, you will be able to work with the program using the skills that you have already developed. 
Include a new sharer by simply adding his/her name in the program Share Wizard. 

 Synchronize/update the shared data with your group members: just click "Send and Receive" in 
Microsoft Outlook, and your new entries in the shared folder will be sent over to their computers and 
automatically update their data 

http://en.wikipedia.org/wiki/Advanced_Encryption_Standard�
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 Ability to Temporarily Cancel Sharing of a Folder or Deactivate Folder Sharing. The ability to 
temporarily disable sharing of a folder is now implemented for advanced administrative purposes, 
allowing you to additionally control what data will be sent or received during a period of time. Before 
going on vacation, you can temporarily disable your folder sharing (stop receiving updates from other 
sharers) without any trouble for other sharers. After returning, you can easily enable sharing again and 
start receiving updates from the other users. 

 Ability to Disable Sharing Completely. For advanced administrative purposes, the sharing process 
can now be completely disabled on all team members' computers from one computer only. 

 Ability to Add sharers From Distribution Lists. You can now share your folder with all contacts of a 
distribution list. 

 Work offline or online. You can change data in the Outlook shared folder offline. As soon as the Internet 
or your company’s network connection is established, you will be able to update your shared folder’s 
data with all teammates automatically by clicking "Send and Receive". Updates are also automatically 
sent when Outlook performs "Send/Receive" for all accounts as scheduled (by default every 5 minutes 
when you are online). Whether you work over the intranet, dial-up Internet or over a dedicated line, 
you can use this product as an ideal instrument for remote companies and groups. 

 No server: all data is sent back and forth with the help of special e-mail messages automatically 
converted into Outlook items 

 "Share..." option from right-click menu of Outlook folders. 

 Ability to quickly exclude/include/lock (mark as "private") any e-mail message from the sharing list. 

 Management panel allows you to manage your sharing information, define user rights and adjust 
different settings for each folder 

 You can use standard Microsoft Outlook encryption methods to secure information that is being sent. 

 You can synchronize shared Outlook items with your PDA or Palm device**** 

 You can use ShareO / ShareCalendar / ShareContacts to synchronize Outlook data between your 
desktop PC and laptop. 

 Sharing filters. The filters will automatically apply to the shared folders. Their settings depend on the 
folder type, and can be adjusted at any time. The filters can save your traffic and time while 
synchronizing your folders. 

 Ignore or Remove Reminders From Any Folder. You can now disable reminders that you don't need in 
the shared folders. Also, by using the "Ignore Reminders" checkbox in the "Management Panel" you can 
disable reminders that arrive to your folder from other users. It is convenient for Outlook 2007, where 
reminders are supported in all folders, not only the default ones 

 Sharing Invitation Form. When you receive a new invitation to share a folder, different destination 
folder options are available to choose from with detailed explanations of each option. 

 Re-sending items with special filter. Filters can be applied when you re-send items to selected user. 
Filter items by date, category, or by sender/receiver (e-mails) 

 No Outlook rules for e-mails with updates. There is no need to adjust Outlook rules with exceptions to 
accept e-mails with updates - they are now ignored automatically. 

 Ability to customize attachment file extension in e-mails with updates. In order to avoid problems with 
anti-virus and anti-spam software, attachment file extension can now be changed to any other so that 
e-mails with updates won't be filtered. 

 Ability to Automatically Add Custom Text to Subject line of Update E-mails. You can now add some 
custom text to the subject line of updating e-mail messages in order to help adjust anti-spam and anti-
virus software and ignore these e-mails for those users who experience problems with such software. 

*Excluding: Deleted Items, Drafts, Outbox, special folders: 4Team Folders, and Schedules4Team Folder. 

**ShareCalendar: For sharing and synchronizing Microsoft Outlook Calendars only. ShareContacts: For 
sharing and synchronizing Microsoft Outlook Contacts only. 

***Old product names: ShareOutlook / Calendar4Outlook / Contacts4Outlook. 

****Standard Outlook folders only, sub-folders are not supported by most PDA/Palm sync software 
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*V Limitations: All-day and other events with Out-of-Office, Tentative or Busy status will be shared as Busy 
Events (Microsoft Outlook limitation). Events with Free Status will not be shared as Free/Busy events (Microsoft 
Outlook functionality). Free/Busy sharing will not work if in the contact details (Free/Busy information that you 
want to see) the "Internet free/busy Address" is not blank. Avoid the situation when different contacts have the 
same email address name (name@domain.com and name@otherdomain.com), as they will be treated as one 
and the same contact. (Microsoft Outlook functionality limitations). 

VI Available with ShareO Security Pack. Not available with the trial version. A separate license and activation are 
required. Available for ShareO only.  
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SYSTEM REQUIREMENTS 

 Windows 2000/XP/Vista/7 
 Outlook 2000 SP3, 2002 SP3, 2003, 2007, 2010 
 E-mail account type: POP3, IMAP4*, Exchange* and/or other email types* 

  
ATTENTION: It is highly recommended that you update your Outlook 2000 or 2002 versions with SP3, 
otherwise you may experience crash problems when sharing folders. 
  
*If you use Outlook Web Mail, Exchange or IMAP, be sure that the e-mail messages from other contacts are 
received in the Inbox folder of Personal Folders (Outlook Today). If not, you will have to create Rules in Outlook 
to direct these e-mail messages to Personal Folders Inbox. 
Rules: Tools->Rules and Alerts (Rules Wizard) ->New Rule...->Modify->Select: "Move messages with specific 
words in the subject to a folder"->Set value to ”specific words” ->Set value to "specific folder"->Click Finish 
button 
Specific words: 

for ShareO (ShareOutlook): 4941419117711 
for ShareContacts (Contacts4Outlook): 5951519117711 
for ShareCalendar (Calendar4Outlook): 6961619117711 
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SHAREO / SHARECALENDAR / SHARECONTACTS VERSIONS 

 Trial: Almost fully functional 14-day trial version. You will not be able to change the sharing filters 
settings during the initial sharing of e-mail folders. 

Full: A fully functional version 

 

FREQUENTLY ASKED QUESTIONS 

Support 
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SOFTWARE UPDATE & ACTIVATION. 

Click on the underlined links. 

What happens if you don't activate your copy of the product? 

Before you activate the product, you may run it for a limited amount of time ( trial version will expire in 14 
days). Afterwards, the program will go into Reduced Functionality Mode. In this Mode you will not be able to 
share and update the shared Folders content. No existing Outlook items or documents will be harmed, and you 
can easily get the program out of this mode by activating it. 

 Product Activation: 

1. Connect to the Internet. 

2. Go to the ShareO menu from Outlook menu. 

3. Select -> Activate... from the program menu. 

4. Enter your* Activation Code in the Activation Code field.** Click here to see screenshot. 

5. Click Next. 

6. If activation is successful you will receive the "Activation Successful" dialog. Click "OK". 

The program will continue functioning as a full version.  

If you receive the Activation failed dialog, click "< Back" and re-enter your Activation Code. If this does 
not help, go to the Support by phone or LiveChat. 

  

 ShareO Security Pack*** Activation: 

1. Connect to the Internet. 

2. Go to the ShareO menu on the Outlook menu bar. 

3. Select -> Options... from the ShareO drop-down menu. 

4. Select Security tab. 

5. Click Activate . 

6. Enter your* Activation Code in the Activation Code field.** Click here to see the screenshot. 

7. Click Next. 

8. If activation is successful, you will see the "Activation Successful" dialog. Click "OK". Your Security 
Pack is activated and the "Enable encryption..." check box will become available. 

If you receive the Activation failed dialog, click "< Back" and re-enter your Activation Code. If this does 
not help, go to the Support by phone or LiveChat. 

Software Update 

1. Connect to the Internet 
2. In the product menu click About ShareO (ShareCalendar / ShareContacts) 
3. Click the "Check for Update" button. 
4. If a new version of the product has been released, remove the old version (Control Panel -> 

Add/Remove Programs) and download and install the new one. 
Note: All your data will be saved and securely translated into a new version. Your Activation Code (your order 
number) will be required. Please click ”Activate” in the product menu and enter the Code. You may purchase a 
group license or separate licenses for each group member from the product web site. For program activation, 
the Code has to be entered on each group member’s computer. 

About product activation 

After the trial version period is over, you will need to activate your copy of the program in order to continue 
using it. This wizard will guide you, step-by-step, through the process of activating via the Internet or over the 
telephone. 
Product Activation is an anti-piracy technology designed to verify that software products have been legitimately 
licensed. It is quick, simple, and helps protect customer privacy. 
Product Activation works by verifying that a software activation code, which you must use in order to activate 
the product, has not been used on more personal computers than intended by the software's license. 
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Note: Please be aware that your Activation (License) Code is linked to your computer(s), and the 
program can be installed only on as many computers as many licenses you have purchased. If you need 
to move the program to another computer, please contact our customer support. 

*The Activation Code will be sent to you by e-mail after you purchase the product. You can purchase the 
product by clicking here. 

**In order to activate the product, you need to purchase it and obtain the activation code. Use "Buy 
online" ( Online Activation dialog) to go directly to the product web site. 
***ShareO security pack required separate license and activation. Not available with the trial version. 
  
Activation Code will be sent to you by e-mail after you purchase the product. You can purchase it by 
clicking here. 
  

http://buy.4team.biz/�
http://buy.4team.biz/�
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GETTING STARTED / INSTALLATION 

Click on the underline links.   

1. Prior to installation: 
a. You need to have Windows Administrator rights in order to install product. 
b. Please check that you are running Microsoft Outlook 2000 (SP-3), 2002 (SP-2), 2003, or 2007 as 

Product is incompatible with an MS Outlook version prior to 2000; check other System 
Requirements as well. You can update your Outlook version here. 

c. POP3 email accounts are more preferable for the program to run, but you can use IMAP or Exchange 
types of accounts. In this case you will need to create a rule moving email with specific word in 
subject from IMAP/Exchange Inbox to Personal Folders Inbox. 
Specific word value: 
• for ShareO: 4941419117711 
• for ShareContacts: 5951519117711 
• for ShareCalendar: 6961619117711 

e. Download the latest version of the product setup file from the 4Team product website or member 
area and distribute among your team members. 

2. Installation 

a. Close Microsoft Outlook. 

b. Install ShareO / ShareCalendar / ShareContacts by downloading and opening the "setup" file from 
product web site http://www.4team.biz/. Installation is required on every team members’ 
computer. 

c. Start Microsoft Outlook. 

d. If Allow Access dialog appears select "Allow access for 10 min" in the next dialog and click 
"Yes". 

 

e. Change the maximum size of data e-mails, if you or your sharers have strict limitations from 
ISPs' or corporate e-mail server on your e-mail account and attachment size of sent e-mail 
messages. Learn more here. 
You are now ready to start sharing folders! 

 Sharing Folders 
 Sharing Documents and Files 
 Synchronize Microsoft Outlook 
 Update/Synchronize shared Outlook Folders 
 Quick Guide 
 Enable data encryption 

  
* Important: When you or your group members add new folder users, they have to select users with e-mail 
addresses that were registered as "My E-mail Address" on their PC's only. Ignoring this Rule will cause data and 
user duplication and reflect product, and Outlook performance. 
Note: ShareO Security Pack is installed along with ShareO installation. The encryption feature is not available 
during trial. To enable Security Pack, a separate license and activation are required. 

http://office.microsoft.com/officeupdate/default.aspx�
http://www.4team.biz/download.asp�
http://www.4team.biz/download.asp�
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Our customer support will be happy to answer all your questions regarding our products installation and 
functionality,  by email or through Live Help Chat/Feedback on our Web site at: http://www.4team.biz, over 
the phone at: (954) 796-8161.  

mailto:support@4team.biz�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912�
http://www.4team.biz/�
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QUICK INSTALLATION AND SHARING GUIDE 
Click on the underlined links. 

1. Check the system requirements here. 

2. Download the latest version at: http://www.4team.biz/ download.asp and save the downloaded file 
to an easy-to-find location. 

3. Install the product by clicking on the downloaded setup file. 

4. Follow the installation instructions that can be found here. 

5. Choose between two main scenarios and read more from the links provided: sharing Outlook folders 
with other participants or synchronizing your Outlook data between your own personal PCs. 

6. Select a folder that you want to share/synchronize and click the "Share..." button on the Microsoft 
Outlook Toolbar. Sharing Wizard will start. 

 

7. Follow the Wizard instructions (Add sharers, Change access rights, Adjust Filters). For advanced 
sharing settings check the box "Set up other advanced sharing settings" in the second step. Use the 
"Next" button to go to the next step. 

8. Repeat 5-7 for each folder you want to share/synchronize or use the management panel for more 
sharing and user access rights options. 

9. Click the "Send/Receive All" button from the Outlook toolbar or Tools menu.  Your information will 
be sent to other participants. 

10. Forward the installation setup file or downloadable link to participants or to your other PCs and install 
the product. Open Outlook and click "Send and Receive". After the data e-mails arrive, a special 
invitation form will appear. Choose a shared folders structure that fits your current scenario and 
accept it. The shared data will be placed in the chosen folders. You may have to wait a while to 
receive all the shared data (click "Send and Receive" one more time). For troubleshooting, click here. 

• For more detailed information about sharing folders, click here, about synchronizing your own PC(s), 
read here. 

• Follow the instructions from the links below (you can forward them to other users): 
 Receiving an invitation to start sharing folders from other members. 
 Manual checking for duplicate items in the selected folder. 

 
Sharing Folders 
Other Sharing methods 
Create Public Folders 
Synchronize Microsoft Outlook 
Sharing Free/Busy time - Scheduling 
Enable data encryption 
Support and Contact us 
  

http://www.4team.biz/download.asp�
http://www.4team.biz/download.asp�
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HOW TO CHANGE THE MAXIMUM SIZE OF DATA E-MAILS 

Introduction: 
ISPs (internet service providers) and corporate e-mail servers have certain limitations on your account as 
to the attachment size of sent e-mail messages. In some cases (Free e-mail accounts providers), this 
limitation is around 2Mb.* Since our product sends data via e-mail attachments, this limitation will 
directly affect the data sharing processes. In some cases the data will not reach your recipients. By 
lowering the maximum data unit size in our program, you can be sure that all your sharers will always 
receive your initially shared data and updates. If any of you (you or your sharers) have dial-up or other 
types of slow internet connections, this option will help to receive the sent data safely. 
Now, with the automatic division by data size of data messages sent via e-mail, you can avoid 
ISPs' (Internet service providers') and e-mail accounts' limitations. The program will automatically divide 
the shared data into 5Mb units (by default), compress, and send them. It is especially useful for smooth 
sharing/synchronization of e-mails with large attachments, documents, and first-time sharing of large 
Inbox, Contacts, and Calendars folders to avoid the loss of shared data due to ISPs' limitations. 
*Default maximum size of data before compression is 5Mb. The actual e-mail's data size depends a lot on the 
type of Outlook items that you sharing and the size of attachments. With the 5Mb data size limitation, you will be 
able to send approximately (~)350 contacts or ~100 e-mail messages without large attachments, or ~50 Calendar 
Events in one email. The average size of an e-mail data message will be 250-500Kb thanks to compression, based on 
average use. 
Please Note that Outlook items with large attachments that exceed the maximum size of data e-mail limitations will 
not be divided; these data e-mails may block sending or receiving this data. Most shared Microsoft Office and text 
documents without pictures usually have their size compressed 5-10 times, but many files are not compressed at all: 
pictures, mp3, mpeg4, other graphics, music, and video files. 
  
How to Change the maximum size of data e-mail: 

1. Go to the ShareO menu from Outlook menu. 

2. Select -> Options from the program menu. 

3. Select -> Advanced tab from the program menu. 
4. In the "limit update message size to:" field change its value to a value that you prefer (this value is 

in Kb, we recommend that you set it within 500 Kb and 10000Kb / 10Mb). ) . 
5. Click "OK". 

You're all set. 
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WORKING WITH PRODUCT 

SHARING MICROSOFT OUTLOOK FOLDERS 
Click on the underlined links. 

1. Open Microsoft Outlook and choose a folder* to be shared. 

2. Click the "Share..." button on the Microsoft Outlook Toolbar. Sharing Wizard will start. 

 

3. Wizard Step 1: Select Contacts to share the Folder with by clicking the "Add" button  
and selecting each member from chosen contact list. You can type the e-mail address of new 
sharers in this window if needed. Click here to see the screenshot.   
Click "Next".  
Important: Make sure that all e-mail addresses of the selected members are correct and that each 
member uses that particular e-mail address in his ShareO (ShareCalendar / ShareContacts). 

4. Wizard Step 2: Set Sharing Filters. Choose what item information should be shared and 
review/adjust the shared filter settings by clicking the "Filters" button. (the filter settings for e-
mail folders are not adjustable in the trial version). For advanced sharing settings check the box 
"Set up other advanced sharing settings". Learn more about this step by clicking here. 
Click "Next". 

5. Wizard Step 3: You have successfully set up the sharing of the selected folder. 
Click "Finish".   

6. Click "Send/Receive All" on the Outlook toolbar or Tools menu. 
Warning:  The Program automatically converts all your chosen Folders content into a special message, divides 
it by size (to avoid your ISPs' account limitation), one message or more per ”Send” or ”Send and Save” click. 
E.g.: if you share your Contacts folder containing 10,000 contact items, ShareO / ShareContacts will create and 
send to your teammates e-mails with a 1-5 Mb attachment(s) (Click here to learn how to change the maximum 
size of data e-mails). A regular update does not usually exceed 50Kb depending on the size of updated items. 
The program compresses all standard items to reduce their size. 
7. Go to the next Computer (PC's), install the product and click "Send and receive". Follow the 

instructions from the links below (pass them to your teammates): 
 Synchronize Microsoft Outlook on two machines 
 Receiving invitation to start sharing folders from other members. 
 Checking for duplicate items in the selected folder. 
 Update/Synchronize the shared Outlook Folders. 
 How to change the maximum size of data e-mail messages 

  
Other Sharing methods 
  
4.2. Wizard Advanced Step: Set Advanced Sharing Options description: 
You can utilize this step for advanced sharing options with additional filters, sub-folders sharing, privacy 
options, enabling data encryption, and "Updates Options" that you can adjust any time in the 
Management Panel. 
  
*Excluding: Deleted Items, Drafts, Outbox, 4Team, and Schedules4Team Folders.   
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SHARING DOCUMENTS AND FILES 

SHARING DOCUMENTS AND FILES 
(available in ShareO product only) 
  
In order to share documents you can add any windows documents and files or windows documents folders 
to any email type Outlook folder using the drag-and-drop, copy-and-paste feature, right-click and "File" 
menu or using the "Add Document..." command from ShareO menu or using right-click or file menu. To 
save your e-mail server's traffic, as well as yours, all these documents will be zipped, sent to sharers and 
automatically unpacked on their  end. 

 
We recommend creating separate folders for shared documents. Click here for screenshot. 
  
The sharing of documents in Outlook folder is as easy as sharing of any other Outlook folder using 
ShareO. Just go to the folder you wish to share, click the "Share..." button on  Outlook toolbar, add 
contacts you wish to share the folder with and click the "Update & Send" button. Refer to section "Sharing 
Folders" for more details. 
  
ShareO allows you to share your documents not only by placing copies of them into an Outlook folder, but 
also by synchronizing the shared Outlook folder with any Windows folder. Refer to "Sharing Windows 
Folder" for details. 
  
Support 
How to share documents securely 
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ADDING DOCUMENTS AND FILES 
(available in ShareO product only) 
  
There are several ways to add files and windows documents folders to Outlook e-mail type folder when 
using ShareO. You can paste files into an Outlook folder using the Paste (Ctrl+V) command in the Outlook 
"Edit" menu. You can also drag-and-drop files into the Outlook folder or use right-clicking on "Share with 
ShareO" menu. 
  
An example of using Copy-and-paste (animated GIF): 
1. Select files in your windows explorer (use mouse click + keyboard Ctrl). 
2. Mouse "Right-Click". 
3. Select "Copy". 
4. Open a Microsoft Outlook shared folder. 
5. Use "paste" from the Outlook Edit menu or "Paste Files" in right-click menu of Outlook folder for 

an easy adding of documents to the shared folder. 

 
  
The ShareO menu " Add Document..." command can also be used to place documents into Outlook 
folders: 
  

 
  
Select the folder you wish to add files to (by default, the currently selected folder is suggested), and then 
add files by clicking the "Add" button. The documents/files you are adding will appear in the list. If you 
need to remove the file after adding it to the list, just select this file in the list with your mouse and click 
"Remove". 
The documents from the list will be placed into the selected Outlook folder when you click on "OK". 
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Add documents to the shared folder from the right-click or File menu. Share documents with ease 
by right-clicking on the file or document, as well as on the file menu available from My Documents or 
Windows Explorer. The Outlook documents folders already shared are available from the menu. Select the 
shared Outlook folder or choose another folder. The selected files will be added to the selected folder and 
shared with the selected users. 

 
  

 
  
Add all content of selected Windows folder in a few clicks. Select the windows folder with the 
documents you want to share. Add documents to selected Outlook folder by right-clicking on the selected 
windows folder, as well as on the file menu available from My Documents or Windows Explorer. Select the 
shared Outlook folder or choose another folder. The selected files will be added to the selected folder and 
shared with the selected users. 
Please Note that you should enable sharing of the selected Outlook folder in order to deliver documents 
to all recipients. We also recommend that you enable synchronization with your windows folder if you 
want to update documents in your windows documents folder as soon their updates appear in your 
Outlook. 
  
NOTE: Due to Microsoft Outlook security restrictions you can't add some types of files to the Outlook 
folder, such as .exe, .com, .bat, .vbs, .mdb, .js, etc. 
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SHARING WINDOWS FOLDERS AND FILES 
(available in ShareO product only) 
  
To share documents and/or other files from any Windows folder, you need to enable synchronization of 
this folder with the currently shared Outlook folder. 
You can easily add all or selected documents and files from the selected windows folder. Learn more here. 
  
To enable synchronization with the Windows folder, follow these steps: 
1. Select the folder in Outlook where you share your documents and/or files. The sharing in this folder 
should be already enabled. If it is not yet shared, enable sharing of this folder (refer to the "Sharing 
Outlook Folders" section). 
2. Go to the "Folder Settings" tab for this folder in the "Management Panel", and click the "Documents and 
Files Settings..." button. 
3. In the "Documents and Files Settings" window select the "Synchronize documents and files of this 
folder with folder on disk" checkbox: 
  

 
  

4. Click "Browse..." and select the Windows folder you wish to synchronize with the current Outlook 
folder. 
5. Click "OK" to enable synchronization. 
  
After enabling this synchronization, all files in the Outlook folder will be converted into links and the 
original files placed into the selected Windows folder. 
When synchronization is enabled: 

- the original files are saved into the Windows folder, and only links are stored in Outlook 
folder, which makes the data size of this Outlook folder in PST file very small 
- any changes made in the Windows folder, including file modifications, adding or deleting files 
will automatically apply to the Outlook folder during the ShareO synchronization process, 
regardless of whether Outlook was running or not when modifications were being made. 
- links stored in the Outlook folder open original documents when you double-click on them 
- deletion of a link in the Outlook folder places the original document into the "Deleted Documents" 
folder created in the Windows folder 

  
You can quickly open the Windows folder that is currently in sync. Just go to the shared Outlook folder 
that is currently in sync, open the drop-down menu near the "Share..." button on the Outlook toolbar, and 
select "Open sync folder". 
  
  
When the file is moved, renamed or deleted from the Windows folder, ShareO will prompt for "broken 
link" during the synchronization process: 
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You can browse for the file by clicking the "Browse for file..." button. If you select another file, the 
broken link in Outlook folder will be replaced with the link to this file, and this new file will be shared. 
"Delete Link" - click this button to remove the broken link from the Outlook folder. In this case this link, 
as well as the copy of the file it refers to, will be deleted on other users' computers. 
"Ignore" - click this button to temporarily ignore this problem. In this case the warning about this 
broken link will appear again next time the ShareO synchronization process starts. 
"Apply for all broken links in this folder" - by selecting this checkbox you are applying the selected 
action ("Delete Link" or "Ignore") for all the broken links in the folder for the current synchronization 
process. 
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PRIVATE ITEMS SHARING 

Avoid the sharing of unwanted and personal items using the following methods: 

1. Uncheck sharing of "private or personal items" in the folder data sharing settings 
(Management Panel). The private items shared settings are not shared by default in a folder. 

2. By changing the private status of each item. You can quickly exclude/include any* items 
(contacts, appointments and meetings, e-mails) from/to the sharing list by opening each item and 
changing the item private status (select the "Private" checkbox available in the right-hand side lower 
corner of the item form). 

3. For e-mail items you can use the "Share / Do Not share" command in the right-click menu of the 
item in the shared folder. 

4. From the Management Panel select "Send updates for this folder Only when I click the "update" 
button" for your Inbox folder in order to mark your items as "private", before they will be sent to 
other participants. 

Important Note: If you are already sharing the unwanted items, there is no way to stop sharing them 
(delete from the other participants PCs). You can move these items to another folder (not shared), mark 
them as "private" and move them to the original folder, in order to delete them from the participants' 
PCs. 

*Excluding Notes items. 
 
Management Panel / Folders Settings 
Sharing Folders 
Support 
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SHAREO SECURITY PACK 
Click on the underlined links. 
 
The ShareO Security Pack features secure communications between users of shared Microsoft Outlook 
folders by enabling password encryption of ShareO data e-mail messages using the highest Advanced 
Encryption Standard (AES-256), which is used in military, government, and enterprise applications. With 
the security pack enabled, you can share your Outlook data and documents with other users securely. You 
can be sure that all password protected data communications between shared and encryption enabled 
Outlook folders on different PCs are secure. The Security Pack is targeted for Private, Enterprise, 
Government, and Military customers that require an additional layer of security for shared data 
communication. 
Note: The Security Pack is an optional advanced feature of ShareO and requires a separate license that is 
not available for trial. A different password can be enabled for different folders (group of users-sharers). 
ENABLING THE SECURITY PACK: 
The Security Pack is included in the ShareO installation. There is no additional setup file to install it. 

1.      Purchase a separate Security Pack license here. Every user needs an individual license. 

2.      Activate the ShareO Security pack on all of the users' PCs. Learn more by clicking here. 

3.      Please make sure that all of your sharers are ready and: 

3.1.      Have installed and activated ShareO 

3.2.      Have installed and activated the ShareO Security Pack 

3.3.      Have the same default or folder password as yours 

3.4.      Have read the instructions on how to use the Security Pack (this page) 

4.      Enable security and set the default password. 

4.1.      Select Options from the "ShareO Menu" on the Microsoft Outlook Menu. ShareO options 
will display. 

4.2.      Select the Security tab. 

4.3.      Check the "Enable encryption/decryption..." box. The "Set Default Password" dialog box will 
display. 

4.4.      Enter the same default password twice into the password fields of the "Set Default Password" 
dialog box (Use a safe password: a combination of minimum of 8 characters, 2 numbers and 2 
capital letters. Remember it.). Click "OK". 

4.5.      The "Set Default Password - Confirmation" dialog box will display. An important note is 
included: please read it! 

4.6.      Click "OK. 

5.      Pass the folder or default password and these instructions on to your sharers via a secure channel 
or method (do not use email). 

6.      You are almost done. Please read the important notes below. 

Important Notes:  

• All new folders that you are sharing will be automatically shared with the default password 
encryption enabled. 

• In order to share data using the Security Pack, the password in the shared folder must be the 
same.  

• All the changes in the already shared folders will be sent encrypted. To avoid that, uncheck 
"Enable encryption..." for each folder you don't want to share encrypted in the "Updates Options" 
dialog box available from the management panel.  

• There is no password restore feature. Please, remember your password.  
• If you change your password, inform other sharers immediately, to prevent a possible loss of 

data. 
WHAT HAPPENS WHEN YOU RECEIVE ENCRYPTED DATA FOR THE FIRST TIME: 
• If the ShareO Security Pack is not enabled, the Password Accept dialog box will display. Click the 

Activate button to activate the Pack or accept later if you do not have the activation code and 

http://en.wikipedia.org/wiki/Advanced_Encryption_Standard#High-level_description_of_the_algorithm�
http://en.wikipedia.org/wiki/Advanced_Encryption_Standard#High-level_description_of_the_algorithm�
http://www.4team.biz/purchase_shareo_se.asp�
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folder password. To get the password, please contact the folder sharer. To get the activation 
code, purchase it here.  

• If the Security pack is enabled, the Password dialog will appear. If you know the Password for the 
shared folder, enter it and click "Accept". Otherwise, click "Accept Later" and contact the folder 
sharer to get the password. If the password of the shared folder is the same as your default 
password, the password dialog box will not display. 

• If you click "Accept Later", the Password Accept dialog or the Password dialog boxes will display 
the next time you start Microsoft Outlook. 

ENABLE/DISABLE SECURITY (ENCRYPTION), CHANGE PASSWORD FOR THE SELECTED FOLDER 
  
Different passwords can be enabled for different folders (group of users-sharers). There are two 
methods/options available to enable/disable security for new or already shared folders. They available 
from: 

1. The sharing Wizard's Advanced step (Open the folder you are sharing or are planning to share. Click 

the "Share..." button  on the Microsoft Outlook toolbar. Check the box "Set up 
other advanced sharing settings..." during the Wizard). Check/uncheck the box "Enable data 
encryption". Click here for the screenshot. 

2. The "Updates Options" dialog box is available from the management panel. Check/uncheck the box 
"Enable data encryption". Click here for the screenshot. 

3. Change the folder Password by clicking the Password button. 
After your set up the folder password, the Update Option dialog box will be updated with the "Folder 
Password" message to the left of the "Password" button.  
Note: Inform other sharers immediately, to prevent a possible loss of data. 
  
Links: 

 How It Works 
 Product Activation 
 Wizard Advanced Step 
 Management Panel / Folders Settings 
 Options

http://4team.biz/purchase_shareo_se.asp�
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SHARING FREE/BUSY TIME - Outlook scheduling (available in ShareO and 
ShareCalendar) 
Click on the underlined links. 
 
About Free/Busy sharing: This enabled option in ShareO / ShareCalendar will allow you to share and access your 
and your Contacts' Free/Busy time via the Scheduling Tab of the Appointment / Meeting Request or use Group 
Schedules in the Calendar folder. Free/Busy sharing will help you schedule all your meetings and appointments. Always 
know your coworkers' and friends' free/busy time without disclosing the subject and private details. Other sharers can 
use this information to see when you are available for meetings or for other time-specific tasks. Free/Busy scheduling 
is based on standard Microsoft Outlook functionality and without ShareO is available for users with Microsoft Exchange 
accounts with proper configuration; with ShareO/ShareCalendar you are now able to share your Free/Busy time even 
without Exchange Server and all your configurations will be set automatically. 

 
How to Share and request free/busy information from your and your colleagues Microsoft Outlook 
Calendar? 

1. Open the Free/Busy Sharing tab in the ShareO Options (available from ShareO menu) and specify 
options for free/busy time sharing: 

2. Enable sharing: A check box "Show my Free/Busy information to the following users" will enable 
the free/busy sharing functionality (enabled by default). 

3. Add shared users to request and share free/busy time: By clicking the Add.../Remove buttons 
the user can add/remove the free/busy information sharers. Clicking the "Add" button will open the 
outlook address book, where a user can choose other participants to be added to the list of free/busy 
time sharers. If a user selects a sharer from the list and clicks the "Remove" button, the deletion 
confirmation message is opened. 

4. Update your Free/Busy Information: Microsoft Outlook menu -> Tools -> Send/Receive -> 
Free/Busy Information. Free/Busy message balloon will notify you in the system tray (Outlook 2003, 
2007). Click Send/Receive on the Outlook menu. Your Free/Busy information and request will be sent 
to other sharers. After your colleagues (sharers) accept the Free/Busy sharing request, you will start 
receiving their Free/Busy information and will be able to schedule and coordinate your meetings and 
FreeBusy time of your colleagues.   
Important Note: We recommend that before making any schedules or meetings, you click Send/Receive to 
update your data with the latest free/busy information from your colleagues. Please read Free/Busy Limitations 
and Troubleshooting here. By installing ShareO or ShareCalendar your FreeBusy settings will be changed, you can 
access them by going to Tools -> Options -> Preferences -> Calendar Options -> Free/Busy Options; your 
Free/Busy information will be updated every 1 minute (you can adjust it from Free/Busy Options). Your 
information will be sent to sharers according to your Outlook send/receive rules or ShareO or ShareCalendar 
settings. Please do not change or delete the path in Free/Busy Options. 
  
How to use scheduling tab and Groups Scheduling: 
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 You can find how to use Microsoft Outlook scheduling from the meeting's Scheduling tab on 
Microsoft Office website by clicking here and Group scheduling by clicking here or in Microsoft 
Outlook help. 

 With ShareO or ShareCalendar you can use this feature with some limitations without Exchange 
server. 

Other Free/Busy settings (Management Panel-> Free/Busy Sharing tab): 
• If "Automatically add users that have access to your default Calendar folder" is checked 

(checked by default), all Calendar sharers will be automatically added to the Free/Busy information 
sharers list. In this case, if you remove a sharer from Calendar, this sharer will also be removed from 
the free/busy information sharing process. But removing a user from this list will NOT remove this 
user from the Calendar folder sharing process. 
  
ShareO/ShareCalendar Free/Busy Limitations: 
 All-day and other events with Out-of-Office, Tentative or Busy status will be shared as Busy Events 

(Microsoft Outlook limitation). 
 Events with Free Status will not be shared as Free/Busy events (Microsoft Outlook functionality). 
 Free/Busy sharing will not work if in the contact details (Free/Busy information that you want to see) 

the "Internet free/busy Address" is not blank. 
 Avoid the situation when different contacts have the same email address name (name@domain.com 

and name@otherdomain.com), as they will be treated as one and the same contact. (Microsoft Outlook 
functionality limitations). 

  
Troubleshooting and Free/Busy FAQ: 
My colleagues accept my Free/Busy sharing request, but I receive message: "No Information." or "No 

free/busy information could be retrieved." 
1. Please ask your colleagues to update Free/Busy Information and Outlook Send/Receive on their 

Outlook. Please wait, the message needs to be delivered to your server (depending on your and your 
colleague's mail servers it may take from seconds up to 10 minutes) 

2. Click Send/Receive in your Outlook 
3. Open Group schedule or scheduling tab of your meeting and check his/her FreeBusy information (add 

him/her from the address book). Please go to the next step if you still have a problem. 
4. Open your colleague's contact form and check his/her Internet Free/Busy Address in the contact's 

details, it must be blank. If not, please make it blank and save the contact. Update your Free/Busy 
time and check your colleague's Free/Busy information. If you are still not able to use Free/Busy 
sharing with ShareO or ShareCalendar, please contact our support. 
How to request to remove you from the sharers list from other sharers' PCs (to stop receiving updates 

from others sharers)? 
1. At this moment ShareO and ShareCalendar do not support automatic requests to delete you from the 

ShareO/ShareCalendar FreeBusy sharers list. You need to send a manual request (email or phone 
call) to your colleagues, and they will delete your contact from the sharers list manually. The next 
steps will help you create a list of your Free/Busy sharers. 

2. Check your Free/Busy information files locations by opening Outlook Free/Busy Options. 
3. Open the Free/Busy information files folder (copy and paste the Free/Busy path to Windows Explorer 

or My documents address bar.) 
4. You will find files with your sharers email address names (name.vfb). You can now create a list of all 

your sharers. Please note that no address domain information is available (this is Microsoft Outlook 
functionality limitation). Please contact our support if you still have the problem. 

http://office.microsoft.com/en-us/assistance/HA011959531033.aspx�
http://office.microsoft.com/en-us/assistance/HA011959531033.aspx�
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CREATE A PUBLIC FOLDER WITHOUT EXCHANGE SERVER 

Create Outlook group calendar, public address book, shared project tasks, sales or support e-mail and 
Journal folders to track participants' responses, shared documents, etc. ShareO's Outlook group folders 
make the group scheduling, handling of project tasks, documents review and coordination, responding to 
support and sales e-mails, and managing customers' contacts easy. 

1. Install the software on participants' computers (PCs) 

2. The participant chosen as folder Administrator creates a folder under personal folders of a chosen 
type (Calendar for Group calendar, E-mail - for documents and e-mails public folder, etc...) 

3. The Administrator adjusts the folder’s settings and the user access rights by using the Management 
panel. 

4. The Administrator adds participants to the selected shared personal folder and clicks "Send and 
Receive". All the data will be sent to the participants. 

5. The participants will receive an invitation that they need to accept by clicking "OK". 

6. Your public folder is ready to work. Any item that any member with full rights puts in the public folder 
will be sent and will propagate to the other users' PCs.  You can always choose any personal folder 
with the data that you already have in your Outlook and share it, to make it public. 

 

Installation 

Quick Guide 

User rights management 

FREQUENTLY ASKED QUESTIONS 

Support 
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OTHER SHARING METHODS (MANAGEMENT PANEL) 
Click on the underlined links.   
  
1. Use the "Share" button that will be available from the right-click menu of any Outlook folder. 

That will open the Sharing Wizard. 
2. Use the Management Panel that will be available from ShareO / ShareCalendar / ShareContacts 

menu. Click here to learn more. 
3. Choose your group members with whom you are going to share this folder, by clicking the 

"Add" button and selecting each member from your contacts. 
4. Define users’ rights and set sharing rules for each folder. The Management Panel allows you to 

conveniently manage your sharing settings for each folder. All your Outlook folders are listed on 
the left-hand side of the window. A folder that is shared with other users appears in boldface. 
Click on each folder and adjust its settings. 

5. Click "Close" or "Save" to update the folders setting and send updated data to the shared users. 
6. Choose the shared filter settings and click the "Send" button. (filter settings are not available in 

the trial version) 
7. Click the "Send/Receive All" button from the Outlook toolbar or Tools menu. 
Note: Please do not use "Re-send Data..." after adding participants; these buttons are used for re-sending 
data only. Use them only if your data is not received by other users. 
  
Important: Make sure that all e-mail addresses of the selected members are correct and that each 
member uses that particular e-mail address in his ShareO (ShareCalendar / ShareContacts). 
  
Note: After the ”update being sent” progress bar appearance or after synchronization the confirmation 
message about the update complete transfer will be displayed. You can select not to show this message in 
the future. 
  
Management Panel Settings 
Sharing Folders 
Support 
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SYNCHRONIZE MICROSOFT OUTLOOK 

Our tools are developed to make the sharing functionality our priority. You can also use this guide to 
synchronize (create identical copies) Outlook between your two or more PCs (i.e. laptop and desktop). We 
are planning to expand our product functionality to synchronize PCs using network folders, flash drives, 
using a central server, etc. These updates will be published as a free addition to the existing product 
and/or as a new product. Please contact our sales for more details. 

Here are our recommendations and steps on how to synchronize Outlook between different computers. 

1. You should have a minimum of one different e-mail account for each PC. It is recommended that you 
use these accounts for the sharing/synchronizing purpose only. If you don't have such an account, set up 
a new one for each PC (name1@company.com for PC1, name2@company.com for PC2). 

E.g.: you already have two PCs with Microsoft Outlook installed and have the same e-mail account on 
both. You will need to set up two additional separate accounts, or make changes to your account 
configurations on both PCs in order to have one e-mail account that is not included in the other PCs e-
mail account list. There are plenty of free pop3 e-mail accounts (such as Yahoo, Gmail, etc.) that you can 
set up in order to use our system. 
We recommend one of the best and one of the most affordable hosting services in the world: 
1and1.com hosting with e-mail accounts for just $0.99 per month for 5 e-mail accounts and 1Gb 
mailbox space. You can learn more and set up your new e-mail account by clicking here. 

Note: If you use the same e-mail account on both PCs for sharing purposes, you will have an increasing 
internet-network traffic, items duplications. Synchronization will not work if you use the same e-mail 
account and the account is not configured to leave a copy of messages on the server. 

2. Start and adjust the initial sharing and synchronization settings from one of the PCs using the e-mail 
account chosen for sharing/synchronization purposes. 

E.g.: You have an e-mail account, name1@company.com, on PC1 and name2@company.com on PC2. 
Start sharing from PC1: Click the Management Panel available from the ShareO menu or from the ShareO 
toolbar. Select a folder you want to share and click the "Add" button and add name2@company.com. 
Adjust the folders sharing settings. Repeat this procedure for all the folders that you want to synchronize. 
Click "OK". Click Send/Receive. 

3. Go to the next computer (PC), install the product and click "Send and Receive" on the Outlook toolbar 
or menu. You will receive invitations to share folders. If you want to receive information in the main 
folders such as the default Calendar, Inbox, Tasks folders, you can browse and select these default folders 
before you accept (click "OK") this invitation. Otherwise, the program will create a subfolder to place the 
received folder content when you click "OK". 

For more information about sharing folders click here. 

  

If you still have any questions please contact us. 

  

Contact us 

Support 

http://www.1and1.com/?k_id=10224639�
http://order.1and1.com/xml/order/MailInstantMail?k_id=10224639�
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RECEIVING INVITATION TO START SHARING FOLDERS FROM OTHER MEMBER: 
Click on the underlined links. 

1. Special e-mail messages from your teammates generated by ShareO (ShareContacts, 
ShareCalendar) should arrive into your Inbox folder. Please do not delete them manually and wait 
for the program to process them. 

2. A special form (Select Target Folder) appears: 

 
3. Choose a destination folder where the shared items will be placed from the following four folder 

structure scenarios, most suitable for your needs (for screenshots click on the links
i. Subfolder (recommended for simple sharing of your data): 

 below) 

The program will create a subfolder under your main folder; i.e. for a shared folder named 
"shared folder", the path with e-mail items will be:  \Inbox\shared folder; with calendar 
events: \Calendar\shared folder, etc.. We also recommend this choice if you wish to make 
public folders structure for your company, such as: Public (Group) Calendars, Contacts, 
shared documents, discussion groups (Forum), etc... 

ii. Main (Default) folder (recommended for synchronization of main folders between your 
own PCs): 
Select this option if you want to receive shared items in your main personal folder. In this 
case, the items of this main folder become also shared/synchronized with other users 
(PCs); i.e. for shared email items: \Inbox, Calendar events: \Calendar, Contacts items: 
\Contacts, etc... 

iii. Folder Structure:  
Select this option if you want all folders received from another sharer to appear as a 
separate sub-folder structure; i.e. \sharer's name\Inbox, sharer's name\Calendar, etc... 

iv. Custom folder:  
Select this option if you want to receive all shared items in a folder of you choice. 
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4. Click "Accept" button to apply your selection. 

Please be aware that: 
• If the e-mail or name of the sender is unknown, use the "Reject" button to reject sharing. After 

you accept sharing of your folder, you folder data will be exposed to other sharers. 
• The selected folder must be of the same type like the one that has been sent to you. 
• If you already have items in the selected folder, they (similar items) will be automatically sent 

back to that person during the first "send/receive" process in Outlook, except those that are 
marked as "private". 

  
 Checking for duplicate 
 Update/Synchronize shared Outlook Folders 
 Other Sharing methods 
 Security Pack 
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CHECKING FOR DUPLICATE ITEMS: 

The program will automatically compare new items that have arrived with items that you already have in 
this folder, and try to automatically merge the data in them. 
By default, the auto-resolving duplicates algorithm ("Search and try to merge duplicate items...") is 
enabled in the Product "Options..." Advanced tab, available from the product menu.  
  
If the program is not able to safely merge duplicates or resolve conflicts, the program will backup all 
problematic items into a special "Duplicate issues" folder and notify you. Then, you can deal with them 
manually. 
  
 The items that are detected as duplicate items, but cannot be merged, are placed into the 

"Conflicts" sub-folder. You can open both the original version (that is currently in your original 
folder), and the arrived conflicting version by right-clicking on the item in this folder and selecting 
"Compare With Original Item" in the menu. 

 If items are automatically merged during sharing, the original items stored in your folder before 
merging will be backed up in the "Backup" sub-folder. If there are many merged items in the 
folder, the original folder backup will be created here, with the exact date and time of the backup, 
with all the items stored there before they merging. 

 When you've reviewed the conflicts and any created backups, you can delete the "Duplicate 
Issues" folder. If any further conflicts or backup instances occur, this folder will be created again. 

  
If auto-resolving feature is disabled, the functionality described here is also disabled and application will 
not check for duplicates at all. 
  
NOTE: The sender will not receive any changes of the above if he uses the "synchronize only" mode or 
"view" right for sharing folder. 
  
 Update/Synchronize shared Outlook Folders 
 Other Sharing methods 
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UPDATE OUTLOOK ITEMS IN THE SHARED OUTLOOK FOLDER 
Click on the underlined links.   

 
There are several ways your updates can propagate to other members: 
1. By default, all your updates are sent out when Outlook performs the "Send/Receive" process. 

This happens when you manually click the "Send and Receive All" button, or when Outlook 
automatically performs the scheduled account synchronization process in accordance with 
Outlook settings (Tools->Options->Mail Setup->Send/Receive...) 
a. If you want your updates in the selected folder to be sent immediately, you can click 

"Update current folder"  on the ShareO Toolbar. 
b. After editing items in several different folders, you may click the "Update ALL folders" 

  icon on the Outlook Toolbar. 
2. Use the Management Panel to define the users’ rights, re-send all or filtered data, and set 

sharing rules for each folder. The Management Panel allows you to conveniently manage your 
sharing settings for each folder. All your Outlook folders are listed on the left-hand side of the 
window. A folder that is shared with other users appears in boldface. Click on each folder and 
adjust its settings. Management Panel available from Outlook toolbar or 
ShareO/ShareCalendar/ShareContacts menu. 

To find out how to adjust the Management Panel and Folders settings, click here. 
3. Re-send folder data: 

1. From the Management Panel select users to whom you are planning to re-send the folder 
data (use CTRL + Click from multiple selection). 

2. Click the "Resend Data..." button. Adjust the filter settings and then click "SEND". 
Please Note: it may take from a few minutes to an hour depending on how many items 
are in your folder. Items quantity as well as any attachments may affect the time for this 
update to be sent / received. Click here to see an example of a filter for the e-mail folder. 

  

Support 
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OPTIONS 
Click on the underlined links. 
  
The Options are available from the ShareO menu located on the Microsoft Outlook menu bar. 

General: 
(Outlook menu -> ShareO (ShareContacts or ShareCalendar) -> Options) 

 Show updates notification icon in the system tray. Use this option to get notifications about 
received updates in the shared folders and for quick access to the updated folders from the 
system tray. 

 Enable the Unread items filter in the toolbar. Use this option if you want to quickly apply a 
filter to toggle between read/unread items in the selected folder. When enabled, the option will be 
available from the product menu in the Outlook toolbar. 

 Also process e-mail messages with updates in the following folders. If you receive e-mail 
updates in a different Personal folder (Inbox), you can enable the program to watch and process 
them by selecting this folder using the "Select folder..." button. Note that this folder will be 
checked additionally. The default Inbox folder is checked for the update e-mails anyway, 
regardless of the selected folder here. 

 Account Settings (Select Account). Click "Select Account..." to enable sending updates from 
your preferred e-mail account (Outlook 2007/2010 only). 

 
  

FreeBusy Sharing: 
(Outlook menu -> ShareO (ShareContacts or ShareCalendar) -> Options -> Free/Busy Sharing Tab) 

 "Show my Free/Busy information to the following users" will enable the free/busy sharing 
functionality (enabled by default). 

 If "Automatically add users that have access to your default Calendar folder" is checked 
(checked by default), all Calendar sharers will be automatically added to the Free/Busy 
information sharers list. In this case, if you remove a sharer from Calendar, this sharer will also 
be removed from the free/busy information sharing process. But removing a user from this list 
will NOT remove this user from the Calendar folder sharing process. 

For more information about Free/Busy sharing click here. 
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Security: 
(Outlook menu -> ShareO (ShareContacts or ShareCalendar) -> Options -> Security Tab) 

 

 
 "Enable encryption / decryption to secure communication between sharers." Available 

with a separate purchase of ShareO Security Pack. 
 Default password. Set up a default password for encryption of all new folders to be shared and 

those existing folders that are being shared without enabled encryption. 
 "Activate..." Activate the ShareO Security Pack license. 

  

Advanced: 
(Outlook menu -> ShareO (ShareContacts or ShareCalendar) -> Options -> Advanced Tab) 
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 "Disable body text of the updating messages." For troubleshooting purposes only. Removes 

the body text of the messages with updates. Enable this option in case your anti-spam or 
antivirus software blocks the ShareO/ShareContacts/ShareCalendar e-mails with updates due to 
the text that exists in the body of these messages (for example, some anti-spam server software 
blocks messages due to linked to .biz domains in the body). 

 "Add the following text to subject of updating e-mails:" You can add some custom text to 
the subject line of updating e-mail messages in order to help adjust anti-spam and anti-virus 
software and ignore these e-mails for those users who experience problems with such software. 

 ”Use other file extension for an attachment...” In order to avoid problems with antivirus and 
anti-spam software, the attachment file extension can now be changed to any other, so that e-
mails with updates won't be filtered. 

 "Limit the size of updating message to:" – the limit of the updating message attachment size 
should be provided there. This limit will be used when generating messages with updates on your 
computer. By default it is set to 5000 Kb (~ 5 Mb). 

 "Search and try to merge duplicate items when receiving updates". Enabled by default. 
Worry free option to deal with duplicates and conflicts. The program will automatically merge and 
remove the received duplicates. If the program is not able to safely merge duplicates or resolve 
conflicts, the program will back up all problematic items into a special "Duplicate issues" folder 
and notify you. Then, you can deal with them manually. 

 "Enable Detailed logging." For troubleshooting purposes only. 
  

Management Panel / Folders Settings 
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ENABLE/DISABLE NOTIFICATION ICON IN SYSTEM TRAY 

Now when updates are received, you will be notified about them. 

 
Notification icon in the Windows system tray will allow you to review the list of recently updated folders 
and quickly open this folder in Outlook. Right-click on  the tray icon and select available options: 

• "Close" will close the Notification icon. Information about the currently showed updates will be 
available after you receive the next updates. 

• Never Show Again. It will disable notification about updates. You can always enable it from the 
ShareO Options (Outlook menu -> ShareO (ShareContacts or ShareCalendar) -> ShareO Options 

• Updated Folder path (path [earliest update time]). To review the received updates click the selected 
folder path to open the folder being updated. 

 
ShareO Options 
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MANAGEMENT PANEL / FOLDERS SETTINGS 

Click on the underlined links. 
Use the Management Panel to define the users' rights, re-send all or filtered data, set sharing rules 
for each folder, and more. The Management Panel allows you to conveniently manage your sharing 
settings for each folder. All your Outlook folders are listed on the left-hand side of the window. A folder 
that is shared with other users appears in boldface. Click on each folder and adjust its settings. 
   

 
1. ADD, REMOVE, CHANGE RIGHTS OF USERS (GROUP MEMBERS): 

 Use the "Add" or "Delete" buttons to add or remove users . You can add a contact to the list 
of sharers or remove this or other contact from it. 

 Define users’ rights for the selected folder by double-clicking the contact from the list or use 
"Change Rights" button for selected users. Full rights – updates are sent to other sharers. 
View rights – updates are not sent. 

 "Resend Data..." button - For re-sending of your folder data. Select users to whom you want to 
resend the data (use CTRL + Click from multiple selection) and click the "Re-send Data..." button. 
Adjust the filter settings and then click "SEND". 
Please Note: it may take from a few minutes to an hour depending on how many items are in 
your folder. Items quantity as well as any attachments may affect the time for this update to be 
sent / received.  To save the sharers' time, as well as yours, we recommend that you use filters. 

2. DATA SHARING SETTINGS: 
Documents and Files Settings... button. 

 
Available for e-mail (documents) type folders only as an advanced option for sharing of documents. These 
settings allow you to enable/disable synchronization of Outlook e-mail type folders with Windows folders. 
Refer to "Sharing Windows Folder Files" section for details. 
  
Select what information should be shared...: 



ShareO/ShareCalendar/ShareContacts for Microsoft Outlook (Printed Documentation) 

42 

 Notes / Comments. When this option is enabled, your personal comments of the items are 
shared with others. 

 Private or personal items. When enabled, all of your personal or private items will be shared 
(Disabled by default). 

 Attachments. When this option is enabled, attachments inside items will be shared with others. 
 New messages by default. (for the "Sent Items" folder only) 
 Auto-share all sub-folders of this folder. When this option is enabled, all sub-folders, created 

in this folder, will also be automatically shared with the same users and other sharing settings. 
 When creating new item in folder, mark item as "private" by default. When this option is 

selected, items that are created in the folder will be marked automatically as "private" items. 
3. OTHER SETTINGS: 

 Send updates for this folder 
 During each send/receive. Worry-free synchronization. During performing Send/Receive, the 

program will automatically process the received updates, create new updates and send them to all 
participants. If your Outlook is scheduled to send/receive e-mail automatically, you will never 
forget about sending updates from the shared folders. And it will be easy to send/receive/process 
updates by simply clicking on the Send/Receive button available on the Outlook toolbar or menu. 

 Only when I click the "update" button. Updates will be prepared and sent if you click the 
"Update current folder" button on the Outlook-ShareO toolbar. This option is convenient if you 
plan to manually send updates after making changes in the current folder (e.g.:  Calendar). 

 Updates Options (Button & Dialog): 
Notifications: 

 Do not mark new or updated items as "Unread". If disabled, you will be able to easily find 
your updated items for the selected folder using the "Filter Unread Only" option from the ShareO 
toolbar. 

 Do not inform me about updates in this folder. When this option is enabled, you won't get 
alerts about the updates received in the selected Outlook folder. 

Deletions: 
 Do not delete item if deleted by other user.  (Enabled by default). When this option is 

enabled, items in your shared folder on your PC will not be deleted if deleted by other users on 
their PC. After the first occurred deletion performed by other user, you'll get a message, where 
you'll be informed about this enabled option. 

 Don't move deleted items into "Deleted Items" folder. When this option is enabled, items 
are automatically replaced complying with the updates that arrive. If unchecked, old items will be 
backed up in Deleted Items folder. 

Reminders: 
 Don't receive reminders set by other users. When this option is enabled, all reminders in 

items that arrive into this folder will be disabled. Note: this option is applied only to updates that 
are received after this option is enabled. If you want to remove reminders from current items, use 
the "Remove Reminders" feature 

Security: 
 "Enable encryption / decryption to secure communication between sharers of the 

current folder" Available with a separate purchase of ShareO Security Pack. 
 "Password..." Set up a password for the current folder. 
 Advanced Actions Button: 

 
 Remove Reminders. When this option is used, all reminders from existing items in this folder 

will be removed. To learn more about this feature click here. 
 Re-Configure to other Folder... Re-configuring the sharing settings to another folder is useful 

if, for an example you need to disable sharing of the current folder, but you do not want to loose 
any updates your users are sending you.  This option allows you to re-configure the current folder 
sharing to another folder. Refer to "Re-configure Sharing to Other Folder" for details. 

 Disable Folder Sharing... This option will help you to temporarily or permanently disable/enable 
sharing/synchronizing of the current folder. Click here to learn more. 

*Excluding: Deleted Items, Drafts, Outbox, 4Team and Schedules4Team Folders. 
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USER RIGHTS MANAGEMENT 

The product has a simple user rights management system. 

Define users' access rights for the selected folder by double-clicking the user or use "Change Rights" 
button for any user from the list of participants available in the Management Panel. 

 
The program will allow any user with any access rights to make any changes (create, modify, delete) to 
the shared or synchronized folder. The difference between the types of user access rights is in how the 
changes made by the users will propagate to other sharers' PCs and what rights a user has to make the 
changes to the shared folders settings. 

The selected sharer's access rights are located under the "Rights" column and can be changed to: 

 Full rights: 

1. All changes (edit, delete existing items, or add new ones) made by a user with "Full" rights in the 
selected shared folder are sent (shared) to all the folder's sharers and will be propagated to their 
PCs.* 

2. The user can change other users rights 

3. The user can change the shared folder settings 

 View rights: 

1. All changes made by users with the "View" rights in a selected synchronized folder are not sent 
(not shared) to other folder sharers. 

2. The user can not change other users' rights 

3. The user can not change the shared folder settings 

In addition to users' access rights you can use the shared/synchronized folder settings that allow to 
managing of what is being shared with other users including updates received from them. 

  

* Except the option "Do not delete if deleted by other user", that can be controlled by other users with the 
same full rights access. 

  

Management Panel / Folders Settings 

Support 
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RE-CONFIGURE SHARING TO OTHER FOLDER 

  
Re-configuring the sharing settings to another folder is useful if, for example, you need you need to 
disable sharing of the current folder, but do not want to lose any updates your users are sending you. 
When you re-configure the sharing settings to another folder, all updates that you receive from the 
contacts in this folder will continue to arrive to another folder that you select. These re-configuring 
process won't affect the sharing settings of other users. 
How to: 
When you want to re-configure the sharing settings from one Outlook folder to another, use this option. It 
is available in Management Panel -> Folder Settings for the shared folders where you have the "full 
access" rights for the sharing settings. 
Select the folder that is currently shared and click on "Re-configure To Other Folder..." button. 

 
The following window appears: 
  

 
  
Choose the folder where you want to transfer your sharing settings. Then decide what to do with the 
items in the currently shared folder (the one you wish to transfer the settings from): 
Copy items into the new folder - this option will copy all items from the current folder to a newly 
selected folder 
Move items into the new folder - this option will move all items from the current folder to a newly 
selected folder, leaving the current folder blank 
Leave items, do not copy them to the new folder - items will remain in the current folder, no items 
will be copied to a newly selected folder 
  
Click "Move" to start the transfer process. 
  
ATTENTION: if the newly selected folder contains any items, they will NOT be shared with 
other users. If you want these items to be shared, you will need re-send the items of this 
folder after the transfer process.   
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DISABLE OR RE-ENABLE FOLDER SHARING 

There may be times when you would want to quickly and effectively, temporarily or permanently, disable 
or enable sharing of you Microsoft Outlook folders. E.g.: to avoid receiving e-mails with a large amount of 
unwanted data e-mail after coming back from vacation or if do not plan to share this folder anymore with 
anyone. The Management Panel offers a 3-click solution on the Folder Settings Tab by clicking on 
Advanced Actions->"Disable/Enable Folder Sharing..." button. 

 
Disable Folder Sharing dialog will appear with three available options: 

1. Temporarily disable sharing of this folder on your machine only. The ability to temporarily 
disable sharing of a folder is now implemented for advanced administrative purposes, allowing you to 
additionally control what data will be sent or received during a period of time. Before going on 
vacation, you can temporarily disable your folder sharing (stop receiving updates from other sharers) 
without any trouble for other sharers. After returning, you can easily enable sharing again and start 
receiving updates from other users. 
The Message "Sharing temporarily disabled" will appear in the Management panel (Folder Settings) 
after applying this action. 

 
2. Remove me from this folder sharing process. It disables sharing of this folder on your machine 

and removes your contact from the list of sharers on other users' computers. All other users will 
continue sharing this folder. 
WARNING: This action cannot be undone. 

3. Cancel this folder sharing process. Or disable sharing this folder completely. For advanced 
administrative purposes, the sharing can now be completely disabled on all team members' 
computers from one computer only.  
WARNING: This action cannot be undone. 
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To re-enable folder sharing from the temporarily disabled status, click the Advanced Actions-
>"Disable/Enable Folder Sharing..." button that available from Management Panel (Folder settings). 
Select "Enable sharing for this folder..." to start receiving and sending updates for this folder. 
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REMOVE REMINDERS 

Starting from Outlook 2007, reminders are supported in any Outlook folder and sub-folder. If you don’t 
want the reminders for items in certain folders to appear in your list of reminders, you can remove them. 
To remove a reminder from the shared folder: 
1. Open Management Panel. 
2. Select the shared folder where you want to remove reminders. 
3. Click the "Advanced Actions" button, and choose the "Remove Reminders..." option there. 
You can also remove reminders from any Outlook folder by right-clicking with your mouse on the folder in 
the Outlook Folder List panel. 
NOTE: Please be aware that after you remove the reminders as described above, you won’t be able to 
undo this action. 
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FAQ, TIPS & TROUBLESHOOTING 

TIPS 

 New or updated items are boldfaced in your shared folder. The number of updated items is also 
displayed. To find new or updated items click the "Unread Only" icon on the toolbar. 

 All items marked as "read" will not be seen under the "Filter Unread Only"   option. Click the 
"View All"  button in order to view the contents of your folder. 

 From the Management Panel select "Send updates for this folder Only when I click on "update" 
button" for your Inbox folder in order to mark your items as private, before they will be sent to 
the participants. 

 Choose the sharing filter settings carefully to avoid sending massive data over your internet 
connection. 
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FREQUENTLY ASKED QUESTIONS (Troubleshooting) 

Click on questions and underline links.  

1. Do Distribution Lists propagate to other users? 

Yes, Distribution Lists propagate to other users. But contacts that can’t be found in Contacts folders 
will not have links to any contacts items in Outlook. 

2. I did not receive any updates or shared information from other PCs. 

• The folder that you share from first PC is empty or you have chosen wrong sharing filters. 
Check that and return to your first PC and re-send all the data using the management 
panel. 

• Your e-mail server or provider has e-mail delays or data e-mails are considered as spam. 
Add all your sharers' e-mail addresses to your Outlook Contacts (if you use exchange, add 
them to your OWA Contact List), ask your administrator to adjust the spam filters by 
excluding messages with numbers in the subject line or adjust data e-mail subject line 
message: 

o for ShareO: 4941419117711 
o for ShareContacts: 5951519117711 
o for ShareCalendar: 6961619117711 

• You e-mail server or provider has a strict e-mail attachment size policy and extension file 
name limitation. Change the attachment extension in Options of the Management Panel. 
Click here to learn more how to change maximum attachment size of data e-mails. 

• If you still would not receive updates contact our Live Help Support 
  

3. My antispam software adds markings ([Spam]) to the subject and/or attachments of your emails and 
they just sit in the Inbox and are not processed. What can I do? 

You should adjust your anti-spam software settings, so that it wouldn't mark emails with numbers: 
for ShareO: 4941419117711, for ShareContacts: 5951519117711, for ShareCalendar: 
6961619117711 in the subject. 

Also, try disabling the body of messages with updates (in General Settings of the Management 
Panel). 

Attachment extensions can be changed in Advanced tab of Options 

4. Do I initiate sharing from one computer or from all? 

You should initiate sharing from one computer. Once the initial sharing is successful, other users will 
receive all the sharing information as well. 

5. When I shared a folder with the other users, they received it to a folder called [username] contacts 
(example). I wanted the data to go to the same folder as it is on my computer. Is this possible? 

You can share the same calendar using this product. However, if you want to do so, you must initiate 
the sharing from one computer only (other sharers should only accept the invitation to join the 
sharing process, but not initiate it). In your case, just delete this folder and ask the owner of the 
folder to re-send it to you using the "Resend" button in the "Management Panel". 

6. I have shared a folder on the first computer and then accepted the invitation on the second. But 
some items didn’t come through.It is possible that the updating e-mails have not reached the other 
user. Try to re-send all items by going to the ShareO / ShareCalendar / ShareContacts menu > 
Management panel, select this shared folder and press the "Resend data..." button. Choose the 
period that includes the missing items and press "Send". 

7. My program has just stopped working, I do not see the program in my toolbar, I have uninstalled and 
reinstalled and cannot seem to get it to work. 

Please open Outlook Help menu->About Microsoft Outlook->Disabled Items and check if anything is 
listed there. If there is ShareO / ShareCalendar / ShareContacts Add-in, enable it and restart 
Outlook. If you don't have any disabled add-ins there, then uninstall 
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ShareO/ShareCalendar/ShareContacts, run Detect and Repair for Microsoft Outlook and install 
product again. 

8. A Security access dialog appears when using ShareO. What to do? 

Security Access Dialog box is a standard Microsoft Outlook message, which usually starts appearing 
with MS Outlook Security Service Pack (SP3). You can’t avoid this message, but you can download 
third party software (freeware - http://www.express-soft.com/ftp/ClickYesSetup.exe) that would 
allow the access automatically whenever the message appears. 

9. The e-mails stay in the Inbox folder and do not get processed. What should I do? 
If you use Outlook Web Mail, Exchange or IMAP, be sure that the e-mail messages from your 
teammates are received in the Inbox folder of Personal Folders (Outlook Today). If not, you will have 
to create Rules in Outlook to direct these e-mail messages to the Personal Folders' Inbox. 
Rules: Tools->Rules and Alerts (Rules Wizard) ->New Rule...->Modify->Select: "Move messages with 
specific words in the subject to a folder"->Set value to ”specific words” ->Set value to "specific 
folder"->Click Finish button 
Specific word: 

• for ShareO/ShareOutlook: 4941419117711 
• ShareContacts/Contacts4Outlook: 5951519117711   
• ShareCalendar/Calendar4Outlook: 6961619117711 

If the e-mails are sitting in the Inbox under Personal folders, you should move these emails to the 
Drafts folder, mark them as "unread" and move them back one by one. If this doesn't help, please 
send us (support@4team.biz) the error.log and Sharelite.log files from My Documents->ShareO 
folder from the problem machine. Contact Support. 

10. I installed the product, but the menu doesn’t show up on Outlook toolbar. 

Please open the Outlook Help menu->About Microsoft Outlook->Disabled Items and check if there is 
anything listed there. If yes, (ShareO/ShareCalendar/ShareContacts Add-in), please enable it and 
restart Outlook. If no, please uninstall the product, run Detect and Repair for MS Outlook (from 
Outlook Help menu) and re-install it. 

11. What fields in the items does ShareO Duplicate Manager check when I receive updates? 

• Mail&Post items: Not checked 

• Calendar items: Subject, Start time 

• Contacts items: Full name, company, or one of 3 E-mails, or Mobile phone 

• Tasks items: Subject, Start time or Subject 

• Journal items: Subject, Start time 

• Notes items: Subject (first line) 

12. Does ShareO share the category list? 

ShareO doesn't share the whole Category list due to the lack of Outlook's functionality. It just shares 
individual Categories used in the shared items. 

13. I am getting appointment reminders from other persons' calendars. How do I get rid of those?You 
can disable the reminders by going to ShareO / ShareCalendar menu > Update options... > "Don't 
receive reminders set by other users". 
Please note that this will disable the reminders for a particular folder only. You should do the same 
for all folders where you don’t want to receive reminders. 

14. Program always uses my default e-mail account in Outlook to send updates. Is it possible to 
configure a different e-mail account to send e-mail messages? 
Unfortunately, this setting cannot be changed in the current product version. It always uses the 
default Outlook account when creating updates. 

15. Can I synchronize any shared folder with my PDA or Pocket PC? 
Any shared folder can be synchronized with PDA or Pocket PC. But usually the synchronization 
software (e.g. Microsoft ActiveSync) allows synchronizing only standard Outlook folders, i.e. 
Calendar, Contacts, Tasks, Inbox and Notes. You can’t synchronize any other folders or sub-folders. 

16.   Do flags propagate to other users along with items? 

http://www.express-soft.com/ftp/ClickYesSetup.exe�
mailto:support@4team.biz�
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Yes, flags do propagate. 

17. Do attachments propagate to other users along with items? 
Yes, attachments are also sent along with any Outlook item that supports attachments. But you can 
enabled/disable this feature for any shared folder in the Management Panel. 

18. Why is the "File As" field in the contacts that I receive different from my settings? 
You may have the "Update File As field" option checked in the settings for this folder. Go to 
Management Panel, find this folder in the list, click on it and uncheck this option. 

19. Can I share other folders using ShareContacts instead of Contacts? 

No. You can't. In order to share any other non-contact type Outlook folders, you should use ShareO. 

20. We have created custom forms in Outlook. Can we share information using these forms? 
Yes, the program supports sharing with custom forms. But make sure you have published these 
forms on all other members' machines before sharing folders, in which they are used. 
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TRIAL VERSION EXPIRED/ How to buy/ Register 

Your trial version expires in 14 days 

If you do not renew (activate) the trial version that is about to expire, you will not be able to use 
program. It is necessary to purchase the license to make the program work. 

Buy Now and you receive: 

• 1 year of free updates. 

• 1 year of free tech support via e-mail and live help. 

  

Click here to Buy ShareO. 

Click here to Buy ShareCalendar. 

Click here to Buy ShareContacts. 

  

Have a Question? 

Please call: +1 (954) 796-8161 or click here to Ask Question Now. 

http://www.4team.biz/purchase_shareo.asp�
http://www.4team.biz/purchase_sharecalendar.asp�
http://www.4team.biz/purchase_sharecontacts.asp�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912�
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UNINSTALL 

1. Close Microsoft Outlook. 

2. Go to Start -> Control Panel -> Add or Remove Programs 

3. Find ShareO (or ShareOutlook), Calendar4Outlook (or ShareCalendar), Contacts4Outlook (or 
ShareContacts) and click "Remove". 
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OTHER 4TEAM PRODUCTS 

You can get acquainted with all 4Team Product line at www.4team.biz. 

Groupware and Sharing tools for Microsoft® Outlook®: 

Schedules4Team Utilize a MS Outlook workgroup calendar without a server with special "Grid view". 

  

Developer’s tools: 

Sync2DB Connect Microsoft Outlook with any* SQL database 

  

Microsoft Outlook Synchronization tools: 

Sync2 makes Outlook synchronization between PCs quick and convenient, over the Internet or LAN, via 
FTP and shared windows folders or using any removable data storage device (Flash drive, CD-RW, PDA, 
iPod, etc.) 

Sync2PST Synchronize Microsoft Outlook PST files. Sync Outlook folders between multiple PCs without a 
server using an external USB device or shared network folder (LAN), and a shared PST file. 

  

Personal Fax Tools: 

Fax4Outlook Internet and regular fax solutions integrated with MS Outlook and other MS Office products. 

  

Mail tools for Microsoft Outlook: 

SendLater Set a schedule for sending your email messages. 

Send2 Send bulk e-mail to recipients from selected folders, e-mails, contacts, meetings, or tasks in one 
click. 

ReplyWith MS Outlook tools simplifies the process of replying repetitive email messages using predefined 
email templates. 

E-mail Responder Auto-response to incoming email, based on your Free/Busy (Out of Office) Status. 

Duplicate Killer Management of duplicates items in the Contacts, E-mails, Notes, Tasks, Calendar Folders 
of Microsoft Outlook 
  

Time saving tools: 
  

Alphabet4Contacts Alphabet Tabs with Smart filters for your Microsoft Outlook Contacts folder. 

Signature2Contacts Capture name and address into Microsoft Outlook address book automatically. 

Notes2 Create and stick notes to Outlook e-mails, tasks, contacts, and appointments. 

Easy2Add - quickly create new events, tasks (to-do), contacts, notes from plain English in your Outlook 
Calendar (appointments, meetings, all day events), Tasks, Contacts and Notes folders. 

  

Import-Export Utilities for Microsoft Outlook: 

vCard4Outlook allows its users to easily convert (import-export) all their Outlook Contacts information 
from/to Vcard format 

SyncWiz for Outlook  Convert (import-export) Outlook Calendar and Contacts from/to vCard, vCalendar, 
iCalendar file format 

  

Dashboards for Microsoft Outlook: 

Personal Folders Dashboard All your Outlook Personal Folders information in one easy-to-navigate 
window. 

http://www.4team.biz/�
http://schedules.4team.biz/�
http://sync2db.com/�
http://www.4team.biz/�
http://sync2pst.com/�
http://fax4outlook.4team.biz/�
http://sendlater.4team.biz/�
http://send2.4team.biz/�
http://replywith.4team.biz/�
http://www.e-mailresponder.com/�
http://duplicatekiller.4team.biz/�
http://alphabet.4team.biz/�
http://signature.4team.biz/�
http://notes2.4team.biz/�
http://www.easy2add.com/�
http://vcard4outlook.4team.biz/�
http://www.sync-wiz.com/�
http://pfd.4team.biz/�
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REPORT PROBLEM, SUGGESTIONS 

• By Online Support Form. 

• By "Live Help" at www.4team.biz. 

• Support by email at: support@4team.biz 

• Sales by e-mail at: sales@4team.biz 

• By phone at: +1 (954) 796-8161. 

  
 
 

http://www.4team.biz/support_form.asp�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912�
http://www.4team.biz/�
mailto:support@4team.biz�
mailto:sales@4team.biz�
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SUPPORT 

Troubleshooting and Support procedure (Get Support): 

1. Make sure that you are running the latest version of the product on all your members or personal PCs. 
You can download the latest product release by clicking here. 

2. Update your Office/Outlook with the latest updates that improve the stability and security of 
Microsoft Office. Click here to go to Microsoft Outlook Office Online website. 

3. Check Systems Requirements. 

4. Refer to Installation procedure. 

5. Search the product FAQ. 

6. Contacting Support: If you cannot solve your problem by any of the previous steps then please send 
the Bug Report email (Outlook Help -> About Product -> Bug Report) to support@4team.biz, or submit 
the Online Support Form, or use LiveHelp with the following information: 

• A detailed description of the problem. Include the steps you have taken to attempt to solve the 
problem already and, where appropriate, the steps to take in order to repeat the problem. 

• The Product version that you are running (ShareO/ShareCalendar/ShareContacts menu -> About 
Product). 

• The Microsoft Outlook version that you are running (Outlook Help -> About Microsoft Office Outlook). 

• The operating system and Office/Outlook version of the computer running the product. 

• Screenshots if available (press PrintScrn on the keyboard and paste (Ctrl + V) to the Word or any 
available picture editor). 

Note: Please remember to keep all of the conversation history when you reply to our emails. 

Click here to submit the Online Support Form. 

  

We provide full support for trial and full version of ShareO / ShareCalendar / ShareContacts: 

• By Online Support Form. 

• By "Live Help" at www.4team.biz. (this is quickest method) 

• By email at: support@4team.biz 

• By telephone at: +1 (954) 796-8161. (only simple questions like product functionality, activations 
problems, sales questions) 

  

To buy the license if your team grows, please click here.* 

Be sure that your computer is online if you want to use this page for orders and support. 

• All our customers who purchased the program or added a new license are eligible to get free updates 
for one year from the last purchase date. 

• If you are looking for other 4Team products for Microsoft Outlook, you can get them at significantly 
discounted prices; just send us an email with your order number, product name, and number of 
licenses that you wish to purchase. 

  

!!! Note: We do not provide support for Microsoft Outlook; please refer to the resources at Microsoft web site. 

* Be sure that your computer is connected to the Internet if you want to use this page for orders and support. 

  
 

http://www.4team.biz/download.asp�
http://office.microsoft.com/officeupdate/default.aspx�
mailto:support@4team.biz�
http://www.4team.biz/support_form.asp�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912�
http://www.4team.biz/support_form.asp�
http://www.4team.biz/support_form.asp�
http://www.4team.biz/support_form.asp�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912�
http://www.4team.biz/�
mailto:support@4team.biz�
http://buy.4team.biz/�
http://support.microsoft.com/�
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